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Managementul proiectelor software 
Laboratorul 8 
 

Înregistrarea valorilor efective 
 
1. Organizarea procesului de actualizare  
2. Înţelegerea opţiunilor de calculare 
3. Actualizarea activităţilor pentru a reflecta informaţiile efective 
4. Folosirea valorilor efectivelor şi a costurilor 
5. Tehnici şi sfaturi pentru actualizare 
6. Revizuirea progresului 
7. Aplicaţii 
 
Valorile efective reprezintă ce s-a întâmplat de fapt în timpul proiectului. În Microsoft Project puteţi 
înregistra informaţii efective despre costul unei activităţi şi despre timpul consumat pentru 
încheierea activităţii. Înregistrând informaţii efective se realizează următoarele lucruri: 
 

• Îi daţi voie Project-ului să reprogrameze automat restul proiectului 
• Asiguraţi conducerii o cale de a evalua cât de bine vă merge proiectul 
• Aflaţi informaţii valoroase legate de aptitudinile voastre de estimator – informaţii pe care le 

puteţi aplica asupra restului proiectului curent si a următorului proiect. 
 
1. Organizarea procesului de actualizare 
 
Înainte de a vă avânta în aspectele mecanice ale actualizării unui proiect, ar trebui să vă opriţi puţin 
să analizaţi procesul de actualizare. Actualizarea unui proiect poate deveni complicată, mai ales 
pentru proiecte mari, cu multe resurse alocate. Trebuie să stabiliţi proceduri manuale eficiente 
pentru colectarea informaţiilor într-un mod convenabil şi apoi trebuie să determinaţi cea mai bună 
cale de a introduce informaţiile in Project. 
Persoanele care lucrează la activităţi ar trebui să răspundă la următoarele întrebări în mod regulat: 
 

• Activitatea e in grafic? 
• Cât s-a realizat? 
• Este disponibilă o estimare revizuita în legătura cu durata activităţii? 
• Este disponibilă o estimare revizuită în legătură cu munca necesară pentru terminarea 

activităţii? 
 
Sfat: Dacă structura are formulare şi procese destinate captării de informaţii despre valorile efective 
şi despre status, folosiţi acele formulare şi procese cât puteţi de mult. Deşi s-ar putea ca la un 
moment anume formularele şi procesele structurii să nu capteze informaţii despre proiect, uneori e 
mai uşor să cereţi puţin mai multe informaţii folosind formulare curente decât să creaţi noi 
formulare şi procese. 
 
S-ar putea să vrei să creaţi un formular pe care participanţii să-l folosească pentru rapoartele lor 
regulate. Rapoartele lor ar trebui să furnizeze informaţiile de care aveţi nevoie pentru a actualiza 
planul proiectului în Project. Aţi putea folosi unul dintre rapoartele din Project  (sau ai putea adapta 
unul dintre rapoartele Project-ului) pentru a furniza informaţiile necesare. 
 
Referinţe: Dacă folosiţi Project într-un e-mail workgroup sau folosiţi Project Server, puteţi profita 
de raportarea electronică. 
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Trebuie de asemenea să hotăraţi cat de des aveţi nevoie să primiţi formularele adunate. Dacă cereţi 
rapoartele prea des, e posibil ca personalul să petreacă mai mult timp raportând decât muncind. Pe 
de alta parte, daca nu primiţi rapoartele destul de des, nu veţi putea să identificaţi un punct 
problemă destul de devreme, astfel încât să îl rezolvaţi înainte de a deveni o criza majora. Ca şi 
manager trebuie să hotăraţi frecvenţa corectă pentru colectarea informaţiilor efective pentru 
proiectul vostru. 
 
Sfat: Puteţi folosi câmpurile timephased in Project pentru a urmări munca şi costurile efective în 
mod zilnic sau săptămânal. Citiţi mai multe despre urmărirea costului cu timephased in secţiunea 
„Urmărirea muncii sau a costurilor in mod regulat” mai târziu in acest capitol. 
  
Când primiţi rapoartele ar trebui să le evaluaţi pentru a identifica activităţi nefinalizate pentru care 
trebuie sa ajustaţi durata planificată, munca şi costurile. Veţi realiza că aceste ajustări sunt cel mai 
uşor de făcut dacă le faceţi înainte să înregistraţi datele efective sau procentajul efectiv de 
îndeplinire a unei activităţi. 
 
De asemenea, ţineţi minte că înregistrarea informaţiilor efective vă permite să comparaţi estimările 
cu valorile efective; această comparaţie se dovedeşte de multe ori a fi destul de valoroasă. Pentru a 
face aceasta comparaţie, asigura-ţi vă că aţi setat baseline pentru proiectul vostru.  
 
2. Înţelegerea opţiunilor de calculare 
 
E nevoie să înţelegeţi opţiunile de calculare pe care le puteţi seta in Project – afectează „bottom 
line”-ul costului cât şi a planului. Puteţi revizui şi schimba opţiunile calculării de la tab-ul 
Calculation din Options. Selectaţi Tools->Options pentru a afişa fereastra de dialog Options, apoi 
faceţi click pe tab-ul Calculation, cum se arată in Figura 1.  
 

 
Figura 1: Folosiţi această fereastră de dialog pentru a seta opţiunile pe care Project le va folosi să calculeze 

planul şi costul proiectului vostru. 
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2.1. Opţiunile Calculation Mode si Calculate:  
 
Puteţi controla când să calculeze Project schimbările pe care le faceţi asupra proiectului; dacă 
alegeţi Automatic, Project vă actualizează proiectul odată ce faceţi schimbările. Dacă alegeţi 
Manual, Project redeschide fereastra de dialog Options şi puteţi face click pe butonul Calculate 
Now pentru a vă actualiza proiectul. Puteţi, de asemenea, să aplicaţi modul de calculare asupra 
tuturor proiectelor deschise sau doar asupra celui activ. Calcularea automata este implicită, dar dacă 
proiectul este foarte mare, calcularea poate lua destul de mult timp; in această situaţie s-ar putea să 
vreţi să schimbaţi opţiunea pe calculare manuală, pentru a face economie de timp. Când proiectul 
este setat pe calculare manuală şi faceţi schimbări care necesită recalculare, vezi Calulate în status 
bar – un memento să calculaţi proiectul după ce terminaţi de făcut schimbările. 
 
2.2. Updating task status updates resource status:  
 
Selectaţi această căsuţă pentru ca Project să actualizeze statusul resurselor pentru a corespunde cu 
oricare status al activităţilor actualizate. (Această opţiune funcţionează şi invers. Dacă actualizaţi 
statusul unei resurse, Project actualizează de asemenea şi statusul activităţii, în mod corespunzător.) 
Să presupunem, de exemplu, că actualizaţi procentajul de îndeplinire a unei activităţi. Când selectaţi 
această căsuţă, Project actualizează de asemenea câmpul % Complete pentru resursă şi alocare. 
 
Notă: Puteţi seta opţiuni de calculare care fac ca Project să modifice datele de început ale 
activităţilor şi să ajusteze porţiunile rămase din activităţi, atunci când activităţile încep devreme sau 
târziu. 
 
2.3. Ajustarea pentru începuturi târzii sau timpurii: 
 
Implicit, când activităţile încep târziu sau devreme, Project nu le schimbă datele de început si nu 
ajustează porţiunile rămase ale activităţilor. Următoarele patru căsuţe sunt noi pentru Project 2003 
şi vă permit să modificaţi această comportare implicita, astfel ca Project să actualizeze activităţile in 
concordanţă cu Status Date: 
 

• Move end of completed parts after status date back to status date – mută sfârşitul părţilor 
terminate după data status înapoi la data status; 

• And move start of remaining parts back to status date – şi mută începutul părţilor rămase 
înapoi la data status; 

• Move start of remaining parts before status date forward to status date – mută începutul 
părţilor rămase de dinaintea datei status înaintea datei status; 

• And move end of completed parts forward to status date – şi mută sfârşitul părţilor terminate 
înaintea datei status. 

 
Sfat: Puteţi găsi data status a proiectului in fereastra de dialog Project Information (Project -> 
Project Information). Dacă data status nu este setată, Project foloseşte data curentă. 
 
Căsuţele pentru bifat funcţionează în perechi – adică, primele două căsuţe se iau împreună şi 
celelalte două la fel. Pentru a înţelege mai bine comportamentul Project-ului şi prima pereche de 
căsuţe, să presupunem că Status Date este 9 decembrie şi aveţi o activitate cu Start Date 14 
decembrie şi o durată de 4 zile. Mai departe, să presupunem că activitatea începe de fapt pe 7 
decembrie. Dacă selectaţi prima căsuţa, Project mută data de start a activităţii la 12/7, setează 
procentajul de îndeplinire la 50% şi programează începutul pentru munca rămasă la 12/16 – astfel 
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creând o activitate divizată. Dacă selectaţi şi a doua căsuţă, Project face modificările pe care le-am 
descris si mută începutul pentru munca rămasă pe 12/9. 
 
Acum luaţi în considerare al doilea set de căsuţe. Din nou, presupunem că Status Date este 9 
decembrie şi aveţi o activitate cu Start Date pe 1 decembrie şi o durată de 4 zile. Mai departe, 
presupunem că activitatea începe de fapt pe 7 decembrie. Dacă selectaţi a treia căsuţă, Project lasă 
data de start a activităţii 12/1, setează procentajul de îndeplinire la 50% si programează începutul 
pentru munca rămasă la 12/9 – din nou, creând o activitate divizată. Dacă selectaţi şi a patra căsuţă, 
Project face modificările pe care le-am descris, dar pe lângă asta, modifică data efectivă de început 
a activităţii pe 12/7. 
 
Atenţie la faptul că aceste opţiuni nu se aplica când înregistraţi informaţii efective în activităţi 
Summary. Aceste opţiuni se aplică doar atunci când faceţi editări a valorii efective totale, incluzând 
munca efectivă totală a activităţii, durata efectivă a activităţii, procentajul de îndeplinire total şi 
procentajul de muncă realizată. Setările acestor căsuţe nu se aplică dacă foloseşti informaţii din 
timesheet de la Project Server pentru a-ţi actualiza proiectul.   
 
 
2.4. Butonul Earned Value:  
 
Faceţi click pe acest buton pentru a seta opţiunile earned value pentru proiect. 
 
Referinţe: Vedeţi capitolul 14 pentru mai multe informaţii despre earned value. 
 
 
2.5. Căsuţa Edits to total task % complete will be spread to the status 
date:  
 
Implicit, această căsuţă nu este selectată, ceea ce face ca Project să distribuie modificările de la 
procentajul de îndeplinire a activităţii către sfârşitul duratei efective a activităţii. Dacă selectaţi 
această căsuţă, în loc, Project distribuie schimbările in mod egal asupra programului până la data 
status a proiectului.  
 
 
2.6. Căsuţa Inserted projects are calculated like summary tasks:  
 
Când această căsuţă este selectată (cum este în mod implicit), Project tratează proiectele inserate 
precum summary tasks când calculează programul proiectului, în loc să le trateze ca pe proiecte 
separate. 
 
Referinţe: Vedeţi capitolul 15 pentru mai multe informaţii legate de inserarea proiectelor. 
 
 
2.7. Căsuţa Actual costs are always calculated by Microsoft Office 
Project:  
 
Când selectaţi această căsuţă, Project calculează costurile efective. Nu puteţi introduce costuri 
efective până când o activitate nu este îndeplinită 100% - Project va rescrie orice cost pe care îl 
introduceţi înainte de îndeplinirea 100%, recalculând costurile. De asemenea, nu puteţi importa 
valori ale costului efectiv. 
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2.8. Lista Default fixed costs accrual:  
 
Folosiţi această listă pentru a alege o metodă prin care Project să crească costurile pentru noi 
activităţi. Puteţi opta ca Project să mărească costurile fixe la începutul unei activităţi sau la sfârşitul 
unei activităţi, sau puteţi distribui costurile în mod proporţional pe toată durata activităţii. 
 
 
2.9. Căsuţa Calculate multiple critical paths:  
 
Când selectaţi această căsuţă, Project calculează şi prezintă diferite căi critice din proiect – şi 
setează data de sfârşit întârziat pentru activităţile fără succesori sau constrângeri pe data de sfârşit 
timpuriu. Prin schimbarea datelor de sfârşit a acestor activităţi, Project face aceste activităţi critice. 
Când deselectaţi această căsuţă, Project setează data de sfârşit întârziat a acestor activităţi pe data de 
sfârşit a proiectului, care scoate aceste activităţi de pe calea critică. 
 
 
2.10. Lista Tasks are critical if slack is less than or equal to x days:  
 
Implicit, Project setează această valoare pe 0 – doar activităţile fără perioada de abatere apar pe 
calea critică. Puteţi forţa activităţi din proiectul tău spre calea critică crescând această valoare. 
 
 
2.11. Butonul Set as Default:  
 
Opţiunile de calculare din partea de sus a ferestrei se aplică tuturor proiectelor. Deşi toate celelalte 
opţiuni din figură se aplică doar asupra proiectului curent, puteţi face ca ele să se aplice asupra 
tuturor proiectelor, apăsând butonul Set as Default. 
 
De-a lungul restului capitolului folosim setările implicite din Project pentru a demonstra efectele 
actualizării unui proiect. 
 
 
3. Actualizarea activităţilor pentru a reflecta informaţiile 
efective 
 
Puteţi înregistra informaţii efective pentru un proiect completând următoarele câmpuri pentru 
fiecare activitate care urmăreşte progresul proiectului vostru: 
 

• Data efectivă de început 
• Data efectivă de sfârşit 
• Durata efectivă 
• Durata rămasă 
• Procentajul de îndeplinire 

 
Notă: Câmpurile menţionate mai sus sunt un posibil set de câmpuri pe care îl puteţi folosi pentru a 
înregistra informaţii efective; există şi alte alternative. De exemplu, unii oameni se concentrează 
doar pe actualizarea muncii efective şi a muncii rămase; in acest caz, Project actualizează câmpurile 
afişate mai sus. 
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În unele cazuri, când introduceţi informaţii in unul dintre aceste câmpuri, Project calculează valorile 
pentru celelalte câmpuri. De exemplu, dacă introduceţi procentajul de îndeplinire pentru o 
activitate, Project calculează şi furnizează o dată de început, o durată efectivă, o durată rămasă şi o 
valoare pentru munca efectivă. 
 
 
3.1. Setarea datelor efective de început şi sfârşit 
 
Vizualizarea Gant Chart prezintă datele de început şi sfârşit proiectate pentru activităţi. In această 
secţiune aflaţi cum sa introduceţi şi să vedeţi date efective de început şi sfârşit (şi să comparaţi 
datele curente, baseline şi efective) în vizualizarea Task Details, ca in Figura 2. 
 
Pornind de la vizualizarea Gant Chart, urmaţi aceşti paşi pentru a vă seta ecranul: 
 

1.Window -> Split pentru a afişa vizualizarea Task Form. 
2.Click pe panoul de jos. 
3.View -> More Views pentru a deschide fereastra de dialog More Views. 
4.Selectaţi Task Details Form si faceţi click pe Apply. 
5.Selectaţi activitatea (în panoul de sus) pentru care vreţi să înregistraţi valori efective. 
6.Selectaţi butonul Actual în panoul de jos pentru a identifica tipul de date pe care vreţi sa le    

introduceţi. 
Cele trei butoane (Current, Baseline si Actual) se refera doar la datele pe care le puteţi  
vedea şi seta. În alte cuvinte, nu vedeţi alocările baseline în josul vizualizării dacă faceţi 
click pe Baseline. 

7.Înregistraţi o dată de început sau de sfârşit şi apasaţi OK. 
 
 

 
Figura 2: Folosiţi formularul Task Details pentru a introduce informaţii efective. 
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Iniţial Project setează câmpurile Actual Start Date si Actual Finish Date pe NA pentru a indica 
faptul că încă nu aţi introdus o dată. Când vă actualizezi proiectul pentru a furniza date efective de 
început şi sfârşit, Project schimbă datele proiectate de început şi sfârşit în datele efective pe care le 
introduceţi. Când introduceţi o dată efectivă de început, Project modifică doar un alt câmp – data de 
început proiectata. Oricum, când introduceţi o dată de sfârşit efectivă, Project modifică alte câteva 
câmpuri: câmpul Percent Complete, câmpul Actual Duration, câmpul Remaining Duration, câmpul 
Actual Work şi câmpul Actual Cost. Dacă nu aţi setat o dată de început efectivă, Project modifică şi 
acel câmp. 
 
3.2. Înregistrarea duratelor efective 
 
Durata efectiva a unei activităţi reprezintă timpul necesar pentru îndeplinirea activităţii. Pentru 
înregistrarea unei durate efective puteţi  folosi fereastra de dialog Update Tasks. Selectaţi  
Tools -> Tracking -> Update Tasks sau faceţi click pe butonul Update Tasks din bara de 
instrumente Tracking pentru a afişa fereastra de dialog Update Tasks, ca in Figura 3. 
 
Sfat: Puteţi  afişa bara de instrumente Tracking selectând View -> Toolbars -> Tracking. 
 
 
 

 
Figura 12-3. Folosiţi fereastra de dialog Update 

Tasks pentru a seta durata actuală pentru o 
activitate, completând câmpul „Actual dur” 

 
Când setaţi o durată actuală mai mică sau egală cu durata planificată, Project presupune că 
activitatea progresează conform programului. Prin urmare, atunci când faceţi click pe Ok, Project 
setează data reală ca data de start planificată – cu exceptia cazului în care aţi setat în prealabil data 
reală de start. În acest caz, Project nu modifică data de start. În ambele cazuri, Project calculează 
procentajul complet şi durata rămasă pentru activitate. 

 

Pentru a vedea durata rămasă actualizată, redeschideţi fereastra de dialog Task Update. 
 
Dacă aţi setat o durată reală mai mare decât durata planificată, Project presupune că activitatea este 
terminată dar că a fost necesară o perioadă mai mare pentru a se finaliza. Project ajustează durata 
planificată pentru a se potrivi cu durata reală şi modifică câmpurile Percent Complete la 100% şi 
Remaining Duration la 0%. 
 
Puteţi folosi tab-ul Calculation din fereastra de dialog Option(Tools->Options) pentru a seta Project 
să actualizeze statusul resurselor atunci când modificaţi statusul unei activităţi. Dacă setaţi această 
opţiune şi apoi setaţi o durată reală, Project de asemenea actualizează şi totalurile de lucru şi costuri 
pentru resurse. 
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Nu modificaţi durata reală a unei activităţi dacă folosiţi planificare bazată pe efort. În 
schimb, modificaţi numărul de unităţi de resurse atribuite sau cantitatea de resurse atribuită. �ineti 
minte că durata unei activităţi bazată pe efort este afectată de atribuirea resurselor. 
 
3.3. Setarea duratei rămase 
 
În cele 2 secţiuni precedente, aţi observat că puteţi folosi vizualizarea Task Form Details şi fereastra 
de dialog Update Tasks pentru a înregistra şi a vizualiza informaţiile propriu zise. Vizualizarea Task 
Form Details oferă un mod limitat de a actualiza activităţile. Deşi fereastra de dialog Update Tasks 
oferă un mod complet de a introduce informaţiile propriu zise, este mai uşor să introduceţi toate 
informaţiile în Project folosind vizualizarea Tracking Table, precum este arătat în Figura 12-4. 
 
 

 
Figura 12-4. Vizualizarea Tracking Table va ajuta să vedeţi şi să  

introduceţi valorile prorpiu zise pentru activităţi 
 
 

Coloana Rem. Dur. (Remaining Duration) arată de cât timp mai aveţi nevoie pentru a termina o 
activitate. Pentru a afişa vizualizarea Tracking Table, deschideţi vizualizarea Grantt Chart şi urmaţi 
următorii paşi: 
 

1. Faceţi click pe panoul din partea de sus a vizualizării Grantt Chart. 
2. Alegeţi Window->Remove Split pentru a afişa vizualizarea standard Grantt Chart. 
3. Faceţi click-dreapta pe butonul Select All şi alegeţi Tracking din meniul care apare. 

Project afişează vizualizarea Tracking Table în partea stângă a vizualizarii Grantt 
Chart. 

 

Pentru a vedea toate coloanele disponibile în vizualizarea Tracking Table, restrângeţi 
porţiunea grafică a ferestrei. 
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Dacă introduceţi o valoare în coloana Rem. Dur. (Remaining Duration), Project presupune că s-a 
început lucrul la acea activitate şi va fi terminată pe baza valorii duratei rămase. De aceea, Project 
setează valorile Act. Dur. (Actual Duration) şi % Comp. (Percent Complete) pe baza combinaţiei 
dintre valoarea duratei care aţi introdus-o şi durata planificată iniţial. Dacă este necesar, Project de 
asemenea setează şi data prorpiu zisă de start. Dacă setaţi opţiunile în Project pentru a actualiza 
statusul unei resurse când actualizaţi statusul unei activităţi, Project actualizează totalul de lucru şi 
costul resurselor atribuite activităţii. 
 
Dacă introduceţi 0 în coloana Rem. Dur. (Remaining Duration), este acelaşi lucru ca şi cum aţi 
introduce 100% în coloana Percent Complete. De exemplu, presupunem că modificaţi valoarea în 
coloana Remaining Duration astfel încât să fie mai mare ca valoarea existentă. Project presupune că 
modificaţi durata planificată a activităţii în loc să urmarească progresul prorpiu zis pentru activitate. 
În acest caz, Project ajustează planificarea pe baza noii durate planificate. Dacă activitatea incepuse 
deja şi aţi introdus o durată propriu zisă, când aţi marit valoarea coloanei Remaining Duration, 
Project adaugă noua valoare estimată la durata reală calculată anterior şi ajustează valoarea coloanei 
Percent Complete. 
 
3.4. Setarea valorii Percent Complete 
 
Puteţi stabili progresul lucrărilor efectuate asupra unei activităţi prin atribuirea unei valori Percent 
Complete unei activităţi. Orice valoare mai mică de 100 indică faptul că activitatea nu este 
completă. Puteţi seta valoarea Percent Complete din formularul Task Details, din fereastra de dialog 
Update Tasks sau din vizualizarea Tracking Table. Sau puteţi selecta activitatea din orice 
vizualizare de activităţi şi folosiţi butoanele pentru procentaje din toolbar-ul Tracking, precum este 
arătat în Figura 12-5. Click-dreapta în orice toolbar şi alegeţi Tracking pentru a afişa toolbar-ul 
Tracking. 
 

 
Figura 12-5. Folosiţi butoanele pentru 
a seta progresul efectiv al activitaii la 

0%, 25%, 50%, 75% sau 100%. 
 
O valoare în coloana Percent Complete afectează de asemenea valorile Actual Duration şi 
Remaining Duration. Dacă introduceţi o valoare într-una din aceste coloane, Project le actualizează 
automat pe celelalte. Cand setaţi valoarea Actual Duration, Project calculează valoarea pentru 
coloana Percent Complete, împărţind valoarea Actual Duration la durata planificată iniţial. Dacă 
setaţi valoarea Remaining Duration, Project recalculează (dacă este necesar) valorile Actual 
Duration şi Percent Complete. 
 
Dacă modificaţi valoarea Percent Complete, Project atribuie o dată de start Actual Start Date (doar 
dacă aţi introdus una în prealabil). Project calculează de asemenea valorile Actual Duration şi 
Remaining Duration. Dacă setaţi opţiunile pentru a actualiza resursele când actualizaţi o activitate, 
Project de asemenea calculează valorile Actual Cost şi Actual Work. Dacă intoduceţi 100 în coloana 
Percent Complete, Project atribuie data de sfârşit planificată coloanei Actual Finish Date. Dacă 
această valoare nu este corectă, nu introduceţi o valoare Percent Complete; în schimb, introduceţi 
Actual Finish Date. 
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3.6. Setarea valorii Work Completed 
 
Uneori, trebuie să programaţi activităţi pe baza disponibilităţii unor anumite resurse. În aceste 
cazuri, urmărirea progresului unei activităţi este mai facilă dacă actualizaţi terminarea activităţii. 
Actualizarea acestei valori actualizează de asemenea lucrul efectuat de fiecare resursă. 
 
Project actualizează necesarul de lucru rămas scăzând lucrul efectuat din totatul de lucru planificat, 
în acelaşi fel în care Project calculează informaţia duratei, când completati câmpul pentru durată. 
 
Folosiţi vizualizarea Tracking Table pentru a introduce informaţii în coloana Act. Work (Actual 
Work), dar porniţi din vizualizarea Task Usage pentru a putea introduce cantitatea le lucru efectuată 
de o anumită resursă. Alegeti View->Task Usage, faceţi click-dreapta pe butonul Select All şi 
alegeţi Tracking din meniul care apare. Probabil veţi fi nevoiţi să trageţi bara de despărţire aproape 
complet spre marginea din dreapta a ecranului pentru a observa coloana Act Work, ca în Figura 12-
6. 
 

 
Figura 12-6. Vizualizarea Tracking Table cu afişarea resurselor 

 

Dacă, în general, planificaţi activităţi pe baza disponibilităţii resurselor, în loc de 
disponibilitatea unei anumite resurse, puteţi folosi această tehnică pentru a înregistra lucrul efectiv. 
Cu toate acestea, trebuie să introduceţi valoarea pe acelaşi rând ca şi activitatea, decât să introduceţi 
valori pe fiecare rând corespunzător fiecarei resurse. Project împarte lucrul efectiv şi cel rămas între 
resurse. 
 

 Project calculează unele câmpuri care conţin valori efective când introduceţi informaţii în 
alte câmpuri care conţin informaţii prorpiu zise. Din acest motiv, este recomandat să creati propria 
voastră versiune a tabelului Tracking care afişează în coloane consecutive câmpurile în care veţi 
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introduce informaţii. Plasarea câmpurilor la un loc într-un tabel Tracking personalizat va facilita 
introducerea datelor – şi oferă de asemenea un mod mai uşor de a introduce informaţii pentru alte 
persoane. Vedeţi capitolul 6 pentru detalii despre customizarea tabelelor. Aţi putea lua în 
considerare, de asemenea, includerea datei statusului proiectului şi data curentă în tabelul de 
Tracking pentru a vă ajuta să gasiţi mai uşor orice activitate necompletată până la data de stare, 
identificând timpul de lucru necesar pentru a fi reprogramat. Pentru a include aceste informaţii, 
trebuie să creaţi câmpuri personalizate. 
 

Pentru informaţii în legatură cu crearea câmpurilor personalizate, vedeţi Capitolul 23. 
 
 
 
4. Folosirea valorilor Actuals şi Costs 
 
Exceptând activităţile bazate pe cost fix, Project foloseşte costul resurselor atribuite unei activităţi 
pentru a calcula costul activităţii. Costurile sunt acumulate, şi costurile totale ale proiectului 
reprezintă suma tuturor resurselor şi costurilor fixe. De aceea, dacă aţi setat şi atribuit în prealabil 
resurse activităţilor dumneavoastră, Project a calculat şi însumat pentru dumneavoastră toate 
costurile – tot ce trebuie să faceţi este să revedeţi şi să analizaţi costurile. 
 
Alternativ, poate doriţi să nu atribuiţi resurse unei activităţi, sau puteţi modifica opţiunile 
predefinite astfel încât Project nu va calcula costurile. Cum puteţi face acest lucru? Alegeti Tools-
>Options pentru a afişa fereastra de dialog Options. În dreptul tab-ului Calculation, priviţi opţiunile 
pentru proiectul dumneavoastră, aşa cum este arătat în Figura 12-7. Dacă checkbox-ul Updating 
task status updates resource status nu este selectat, Project nu va calcula costurile proiectului 
dumneavoastră. Tineţi minte, totuşi, că acest checkbox este selectat în mod implicit, aşa cum se 
poate vedea în figură. 
 

 
Figura 12-7. Din tab-ul Calculation al ferestrei de dialog Options  
puteţi seta dacă doriţi ca Project să calculeze sau nu costurile 

 proiectului dumneavoastră 
 

Dacă nu aţi alocat resurse sau aţi schimbat setările implicite, Project nu poate calcula costul 
proiectului dumneavoastră decât dacă furnizaţi informaţii suplimentare dupa ce activitatea a fost 
finalizată. Puteţi revedea şi actualiza costurile proiectului dumneavoastră dintr-unul din cele 2 
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tabele de cost: tabela Cost pentru activităţi sau tabela Cost pentru resurse. Puteţi de asemenea 
suprascrie costurile pe care le atribuie Project. 
 
4.1. Folosirea tabelei Cost pentru activităţi 
 
Tabela Cost pentru activităţi, din Figura 12-8, prezintă informaţiile despre cost, pe baza fiecărei 
activităţi a proiectului dumneavoastră. Acest tabel arată costul de bază (costul planificat), costul 
real, diferenţa dintre costurile planificat şi cel real, şi costul rămas pentru activitatea respectivă. 
 
Dacă alocaţi un cost fix la o activitate în acest tabel, Project adaugă costul fix la costul calculat 
pentru activitate. Pentru a afişa acest tabel, porniţi din vizualizarea Grantt Chart. Apoi faceţi click-
dreapta pe butonul Select All pentru a arăta meniul de scurtături pentru tabele şi alegeţi Cost. De 
asemenea, este posibil să trebuiască să glisaţi panoul diagramă în partea dreaptă pentru a putea 
vedea toate câmpurile tabelei Cost pentru activităţi. 
 

 
Figura 12-8. Tabela Cost pentru activităţi. 

 
Tabela Cost pentru activităţi este foarte utilă dacă aţi salvat o vizualizare de bază a proiectului 
dumneavoastră, deoarece vă permite să comparaţi costurile de bază cu cele reale. 
 
4.2. Folosirea tabelei Cost pentru resurse 
 
Tabela Cost pentru resurse e asemănătoare celei pentru activităţi, cu împărţirea costului pe resurse, 
nu pe activităţi, aşa cum este prezentat în figura 12-9. 
 
Pentru a afişa tabela, începeţi cu o vizualizare pentru resurse, precum vizualizarea Resource Sheet. 
Apoi faceţi click-dreapta pe butonul Select All şi alegeţi Cost din meniul de scurtături care apare. 
 
Asemeni tabelei Cost pentru activităţi, tabela Cost pentur resurse este folositoare dacă aţi salvat o 
vizualizare de bază a proiectului, deoarece vă permite să comparaţi costurile de bază cu cele reale. 
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Figura 12-9: Tabela de cost pentru resurse 

 
 
 
 
4.3. Suprascrierea  evaluării  costului  resurselor 
 
 
Setările implicite ale proiectului actualizează în mod automat costurile pe măsură ce se înregistrează 
progres într-o activitate. Project foloseşte metoda de angajamente ce a fost aleasă pentru resursă 
atunci cand aceasta a fost creată. 
 
Ca alternativă, puteţi introduce costurile propriu-zise pentru atribuirea unei resurse, sau puteţi 
urmări costurile separat de munca propriu-zisă la o activitate. Pentru a face astfel, după ce 
activitatea sa terminat, trebuie să introduceţi costurile manual pentru a suprascrie costurile calculate 
de Project. Înainte de a putea suprascrie costurile calculate de Project trebuie sa opriţi una din 
opţiunile implicite. Urmăriţi aceşti paşi pentru a ajusta setările implicite ale Project astfel încât să 
puteţi suprascrie costurile calculate: 
 

1. Alegeţi Tools  Options pentru a afişa caseta de dialog Options. 
2. Apăsaţi tab-ul Calculation. 
3. Deselectaţi  căsuţa Actual costs are always calculated by Microsoft Office Project, după 

cum se vede in figura 12-10. 
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Figrua 12-10: Revizuiţi setările implicite pentru a suprascrie 

costurile calculate de Project. 
 
 
 

4. Apăsaţi OK. 
5. Alegeţi View  Task Usage 
6. Apăsaţi click-dreapta pe butonul Select All  pentru a afişa meniul de scurtături pentru tabele, 

şi alegeţi Tracking. Project afişează vederea Tracking Tabel, după cum se poate vedea în 
figura 12-11. 

7. Trageţi bara de despărţire spre dreapta astfel încât să puteţi vedea toate coloanele. 
8. Alegeţi activitatea sau resursa căreia vreţi să îi atribuiţi costul. 
9. Introduceţi costul in coloana  Act. Cost  (Cost propriu-zis). 

 
 
 

Sfat: 
Daca vă răzgândiţi, şi vreţi ca Project să calculeze costurile aşa cum o făcea iniţial, repetaţi paşii 1 
şi 2 pentru a afişa tab-ul Calculation din caseta Options şi bifaţi casuţa Actual costs are always 
calculated by Microsoft Office Project pentru a vă restaura metoda de calcul implicită. Project vă va 
avertiza că urmează să suprascrie orice cost introdus manual atunci când apăsaţi OK. 
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Figura 12-11: Vederea Tracking Tabel cu coloana Act. Cost (Cost propriu-zis) vizibilă. 

 
 
5. Tehnici şi sfaturi pentru actualizare  
 
Utilizatorii de Project pot găsi metode de a accelera procesul de actualizare. De exemplu puteţi face 
următoarele: 

 
• Folosirea câmpurilor timephased (resurse, activităţi distribuite pe o perioadă de timp) pentru 

a actualiza uşor proiectul în mod regulat. 
• Actualizaţi progresul a mai multe activităţi simultan. 
• Reprogramaţi munca incompletă astfel încât să înceapă la data curentă. 

 
 
Notă:  
Puteţi creşte viteza introducerii datelor dacă creaţi o tabelă de urmărire  personalizată care să 
grupeze câmpurile în care se introduce informaţia propriu-zisă. E posibil să doriţi să luaţi în 
considerare includerea datei de status a  proiectului şi a datei curente in tabela de urmărire pentru a 
vă ajuta in găsirea uşoară a activităţilor neterminate înaintea datei de status, identificând munca ce 
trebuie reprogramată. Pentru a include această informaţie trebuie create câmpuri personalizate. 
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5.1. Urmărirea muncii sau a costurilor în mod regulat 
 
Câmpurile timephased din cadrul Project permit actualizarea progresului proiectului în mod regulat, 
cum ar fi zilnic sau săptămânal. Pentru a folosi câmpuri timephased pentru a înregistra informatii de 
progres pentru resurse, începeţi prin a afişa vizualizarea Resource Usage (alegeţi View  Resource 
Usage). Apăsaţi apoi click dreapta pe butonul Select All, şi selectaţi Work din meniu de scurtături 
ce apare pentru a schimba tabela. Ecranul ar trebui să semene cu figura 12-12. 
 
 
 

 
Figura 12-12: Pregatindu-ne pentru a folosi campuri timephased 

 
 

 
O să vreţi să folosiţi majoritatea părţii drepte a vizualizării, dar în partea stangă a vizualizării aveţi 
nevoie doar de coloana Actual Work ce este ascunsă în partea dreaptă a vizualizării. Puteţi să mutaţi 
bara de separare către dreapta, însă veţi pierde partea dreapta a vizualizării. Sau, după mutarea barei 
de separare, puteţi ascunde toate coloanele între coloana Resource Name şi coloana Actual Work – 
pentru a le reafişa trebuie să le inseraţi pe fiecare dintre ele. 
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Pentru a seta partea stangă a vizualizării. astfel încât să puteţi vedea coloana Actual Work, inseraţi 
coloana respectivă între coloana Resource Name şi coloana % Comp.(procentaj finalizat). Pentru a 
insera coloana umaţi paşii următori: 
 

1. Apăsaţi pe titlul coloanei Percent Complete pentru a selecta intreaga coloană. 
 

2. Alegeţi Insert Column pentru a deschide caseta de dialog pentru definirea coloanelor 
(Column Definition), după cum se vede în figura 12-13. 
 

 
Figura 12-13: Adauga coloana Actual Work  

din caseta de dialog pentru definirea coloanelor 
 
 

3. Deschideţi lista Field name şi selectaţi Actual Work. 
4. Apăsaţi OK. 

 
Project inserează coloana Actual Work la stânga coloanei % Comp. şi la dreptul coloanei Resource 
Name. 
 
În continuare trebuie să vă decideţi cât de des vreţi să se actualizeze proiectul. Pentru a se actualiza 
zilnic nu trebuie să faceţi nici o modificare în scala de timp din partea dreaptă a ferestrei. Însă, dacă 
vreţi să se actualizeze săptămânal (sau cu altă frecvenţă), trebuie să schimbaţi scala de timp. Pentru 
a schimba scala de timp alegeţi Format Timescale. Project deschide caseta de dialog Timescale, 
după cum se vede în figura 12-14. Acest exemplu nu necesită nici o schimbare a scalei de timp, dar 
dacă aţi dori să schimbaţi scala de timp în săptămânal (de exemplu), alegeţi un rând, deschideţi 
caseta de liste Units, şi selectaţi Weeks. Apoi ascundeţi celelalte rânduri folosind opţiunile din 
caseta de liste Show din secţiunea de opţiuni ale Timescale din orice tab al rândului. 
 
Când adăugaţi un câmp timephased în coloana Actual Work puteţi vedea rezultatele în timp ce se 
actualizează programul. Alegeţi Format Details Actual Work. Project adaugă un rând în partea 
dreaptă a vizualizarii pentru fiecare activitate. Pentru a introduce ore muncite într-o anumita zi, 
apăsaţi litera coloanei reprezentând ziua respectivă pentru a selecta intreaga zi, dupa cum se vede în 
figura 12-15. Apoi introduceţi numărul de ore pentru activitatea şi resursa corectă în coloana 
Resource Work pe care aţi adăugat-o în partea stângă a vizualizarii.  
 
Notă: 
Ţineţi minte, cu toate astea, că nu puteţi adăuga costuri pentru a suprascrie costurile calculate 
automat de Project decât dacă deschideţi caseta de dialog Options (alegeţi Tools Options), 
selectaţi tabul Calculation, şi debifaţi căsuţa Actual costs are always calculated by Microsoft Office 
Project. 
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Figura 12-14: Folosiţi caseta de dialog Timescale pentru a modifica  
incremenţii ce apar în partea dreapta a vizualizării Resource View 

 
 
 

 
Figura 12-15: Adăugaţi informaţii în campul Actual Work pentru o zi anume 

 
 
De asemenea, întregul proces functionează şi dacă actualizaţi costurile zilnic, cu următoarele 
modificări minore: 
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• Porniţi din vizualizarea Task Usage în loc de vizualizarea Resource Usage 
• Adăugaţi tabela Tracking în loc de tabela Work. 

 
 
Sfat: 
Pentru a ascunde coloana Actual Work pe care aţi adăugat-o în partea stângă a vizualizarii, selectaţi 
întreaga coloană şi alegeţi Edit Hide Column. Partea stângă a vizualizării se intoarce la înfăţişarea 
implicită. Pentru a ascunde rândul Actual Work, adăugat în partea dreaptă a vizualizarii, alegeţi 
Format Details Actual Work din nou şi debifaţi Actual Work. 
 
 
5.2. Accelerarea procesului de actualizare 
 
Dacă aveţi cateva activităţi ce se desfaşoara conform programului sau care sau terminat conform 
programului, puteţi actualiza aceste activităţi împreună urmând următorii paşi:  
 

1. Selectaţi vizualizarea Gantt Chart 
 
Sfat:  
Dacă doriţi să actualizaţi întregul proiect nu selectaţi nici o activitate 
 

2. În coloana Task Name alegeţi activitatea ce doriţi să o actualizaţi. De exemplu, figura 12-16 
prezintă trei activităţi selectate pentru actualizare.  

 
 

 
Figura 12-16: Selectarea activităţilor ce trebuie actualizate 
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Aveţi posibilitatea să selectaţi activităţi folosind aceleaşi tehnici pe care le folosiţi în Windows 
Explorer. Pentru a selecta două sau mai multe activitaţi adiacente, click pe primul task, apasati 
Shift, şi apoi dati click pe ultimul task. Pentru a selecta două sau mai multe activitaţi neadiacente, 
tineţi apasat Ctrl în timp ce apasaţi click pe fiecare task pe care doriţi să îl selectaţi. 
 
3. Alegeţi Tools➪Tracking➪Update Project pentru a vizualiza dialog box-ul Update Project, aşa 
cum apare în figura 12-17 
 
 
 
 
 
 
 
 
 

Figura 12-17: Utilizează caseta de dialog Update Project pentru a actualiza proiectul. 
 
4. Asiguraţi-va că în list box-ul de langă butonul de opţiune  Update work apare o data 
calendaristică corecta. 
5. Selectează una din urmatoarele opţiuni: 

• Set 0% – 100% complete : aceasta indică proiectului să calculeze procentul de completare a 
fiecărei activitaţi. 

• Set 0% or 100% complete only: selectaţi aceasta opţiune pentru a marca activităţile 

finalizate cu 100%  şi lăsa activităţile nefinalizate la 0%. 

6. Specificaţi dacă se actualizeaza întregul proiect sau numai activităţile selectate prin bifarea 

opţiunii adecvate. 

7. Apăsaţi OK. 

 
NOTA: Când selectaţi opţiunea Entire project la pasul 6 şi actualizaţi proiectul, se setează data 

actuală a proiectului cu data pe care aţi selectat-o la pasul 4. 

 

 

5.3. Replanificarea muncii nefinalizate din proiectul provizoriu 
 

         Dacă actualizaţi proiectul şi există activitaţi completate parţial, se poate garanta ca nici o 

muncă nefinalizată nu va fi stabilită spre desfaşurare intr-o dată calendaristica ce a trecut deja.  
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Puteţi fi sigur că toată munca rămasa este fixată pentru daţi calendaristice viitoare, prin 

replanificarea ei, având ca punct de start data curentă. 

 
NOTA: În Project 2000 şi versiunile anterioare, dacă replanifici  munca folosind tehnica descrisă în 

aceasta sectiune, Project ar şterge  constrângerile aplicate activităţilor. De exemplu, presupunând ca 

se replanifică munca dintr-o activitate ce are constrangerea  Must Finish On, şi reprogramarea mută 

data finală dincolo de data limita. 

 

Project 2000 şi versiunile anterioare nu ţineau cont de constrangerea de data calendaristică; în 

schimb, aceste versiuni au inlocuit această constrangere cu As Soon As Possible.  Pentru a păstra 

constrângerile activitaţilor, trebuia replanificată manual munca ramasă. Incepând cu Project 2002, 

proiectul nu mai inlatură constrangerile şi replanifică task-urile fară progres. Totuşi, fiţi atent că 

acest comportament poate lăsa proiectul intr-o situaţie nerealistă. Dacă survine aceasta situaţie, 

proiectul afişează un mesaj şi puteţi  efectua manual schimbări, în funcţie de  necesităţi.  

 
 Urmăriţi aceşti paşi pentru a replanifica munca ramasă pentru daţi calendaristice viitoare: 

 

1. Selectează Gantt Chart view. 

2. Selectează coloana Task Name şi selectează activităţile pe care vrei să le actualizezi. Vezi în 

secţiunea anterioară tehnicile pe care le puteţi  utiliza în selectarea de activitaţi. 

3. Alege Tools➪Tracking➪Update Project pentru a deschide fereastra de dialog Update 

Project,  ca în figura 12-18.  
 
 
 
 
 
 
 

Figura 12-18: Utilizeaza aceasta fereastra de dialog pentru a reprograma munca nefinalizata să inceapa azi. 
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4. Selectează opţiunea Reschedule uncompleted work to start after, şi alege data de la care vrei 

să reprogramezi intreaga munca nefinalizată.  

 

NOTA: Project 2000 a introdus posibilitatea de a seta o data calendaristică pentru care puteţi  

replanifica munca nefinalizată. Totuşi, presupunând ca replanifici munca de doua ori;  Project 2000 

a ignorat toate datele cu excepţia primei replanificari pe care  ai inlocuit-o. Incepand cu Project 

2002, proiectul replanifică task-urile selectate de fiecare data când schimbi data calendaristică. 

 

5. Specificaţi dacă se actualizeaza intregul proiect sau numai  activităţile selectate , prin bifarea 

optiunii potrivite. 

6. Apasaţi OK. 

 

NOTA:Cand replanificaţi o activitate parţial completată folosind tehnica tocmai  descrisă, proiectul  

desparte automat activitatea între partea completata şi cea ramasa. Din acest motiv, în Gantt Chart 

se poate vizualiza o activitate împarţită ,care are un spatiu între cele doua parţi, deoarece partea 

completată poate fi incheiată  uneori înainte ca partea ramasă să fie  planificată să inceapă. 

  
 
6. Revizuirea evoluţiei 
 
 Când incepi înregistrarea efectiv, vei dori să revizuieşti evoluţia proiectului – şi Project te 
poate ajuta. 
 
 
6.1. Folosind Tracking Gantt view  
 
        Tracking Gantt view,  figura 12-19, foloseşte Entry table şi probabil furnizează cea mai 
frapantă imagine a evoluţiei proiectului. Bara de jos din porţiunea graficului( hasurile negre de pe 
ecran) reprezintă liniile de baza a fiecărei activitaţi. Bara de sus masoară ambele date planificate, de 
început şi sfarşit ,sau ( dacă o activitate a fost completată) cu datele de început şi sfârşit pentru 
fiecare activitate.  
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Figura 12-19: Tracking Gantt view vă ajută să inţelegeţi evoluţia proiectului 

 
NOTA: Dacă o activitate este incheiată, un semn de marcare apare în coloana de indicare în partea 
stangă a vizualizării,langă activitate. 
 
 
Proiectul formatează bara de lucru să indice statusul activitaţii după cum urmează: 
 

• Dacă o activitate este planificată, dar nu este încă completă, bara de sus apare cu haşuri bleu 
( apare rosie dacă activitatea este intr-o direcţie critică). 

• Dacă activitatea este completă, bara apare cu albastru închis (apare roşie dacă activitatea 
este intr-o direcţie critică). 

• Dacă activitatea este parţial completă, porţiunea completată apare cu albastru închis în bara 
de sus, iar porţiunea nefinalizată apare cu haşuri bleu ( apar haşuri roşii dacă activitatea este 
intr-o directie critică). 
 

 
6.3. Folosind tabela de lucru pentru activităţi 
 
Tabela de lucru pentru activitaţi, figura 12-20, arată timpul în intregime care este solicitat de la 
toate resursele pentru a completa activitaţile. Munca se deosebeşte de durata activitaţii în 
următoarele moduri: 

• Munca masoară câte ore de efort sunt necesare pentru a completa o activitate. 
• Durata activitaţii masoară volumul de timp (numar de zile) care sunt alocate activităţii. 
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Figura 12-20: Tabela de lucru pentru activitati. 

 

Dacă munca totală pentru o activitate este de 16 ore dar durata activitaţii este de numai o zi, 
puteţi  avea nevoie să adaugi alte surse ( însemnand ca două persoane pot completa activitatea intr-o 
zi) sau să extindă durata activitaţii. 
   Tabela de lucru pentru activitaţi include linii de baza (baseline) astfel încat să puteţi  
compara progresul tău cu cel estimat iniţial. 
  Pentru ca această tabelă să fie semnificativă, aşadar, trebuie să ai salvată o linie de baza 
pentru proiect. Puteţi  introduce informaţii în tabela de  lucru pentru activităţi. 

Puteţi  folosi de la  tabela de lucru pentru activităţi orice pagină de vizualizare a activităţii.  
De exemplu, în figura 12-20, tabela de lucru apare în partea stângă a vizualizarii Task Usage. 
Alegeţi View➪Task Usage; apoi click dreapta pe butonul Select All şi apoi alegeţi Work din 
scurtătura care apare. 
 
 
6.4. Folosirea Tabelei de lucru pentru resurse 
 
 Tabela de lucu pentru resurse, aratată în figura 12-21, exemplifică  informaţiile ce descriu 
munca desfasurata de fiecare resursa.Din nou, munca reprezintă timpul total care este solicitat de 
resurse pentru a-şi finaliza activitatea.Tabela de lucru pentru resurse include de asemeni linii de 
bază , astfel încat să puteţi  compara progresul tău cu cel estimat iniţial.  
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Figura 12-21: Tabela de lucru pentru resurse 

 
 Puteţi  utiliza Tabela de lucru pentru resurse pentru orice pagină de vizualizare a respectivei 
resursei. În figura 12-21, de exemplu, tabela de lucru pentru resurse apare în partea stangă a 
vizualizarii Resource Usage. Selectează vizualizarea Resource Usage din bara de vizualizare; apoi 
click dreapta pe butonul Select All şi alege Work din scurtatura ce apare.  
 
 
6.5. Vizualizarea liniilor de progres  
 
 Proiectul conţine un  alt instrument pe care îl puteţi  folosi pentru a arăta progresul pe care îl 
faci la proiect- dacă ai salvat   linia de bază a proiectului tău. Dacă ai adaugat linii de progres la 
Gantt Chart-ul proiectului tău, ca în figura 12-22, Proiectul deseneaza o linie care conecteaza 
activitatile în progres. Linia de progres creeaza un graphic la proiectul tău cu varfuri punctuate la 
dreapta  pentru munca ce este inaintea planificarii şi varfurile punctate la stanga pentru munca ce 
este în urma planificarii. Distanţa între varfuri şi linie indica gradul cu care activitatea este inaintea 
sau în urma planificării. 
 



 

 26

                      
Figura 12-21: Gantt Chart cu linia evolutiei adaugata. 

 
Pentru a adauga o linie de progres, urmariţi acesti paşi: 
 

1. Alegeţi View➪Gantt Chart. 

2. Alegeţi Tools➪Tracking➪Progress Lines pentru a deschide caseta Progress Lines şi afişaţi 
Datele şi Intervalele. 

3. Selectaţi Display selected progress lines pentru a activa lista Progress Line Dates. 
4. Apasaţi o data lista Progress Line Dates. Proiectul afişeaza o caseta cu sageată 
5. Apasaţi caseta cu sageata, şi vă va apărea un calendar mic , ca cel care apare în  Figura 12-

23. 
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Figura 12-23: Datele şi Intervalele casetei Progress Line 

 
 
6. Selectaţi o data pentru linia de evolutie. 
7. Selectaţi fie Actual plan sau Baseline plan în Afisarea liniilor de evolutie în legatura cu  
panel-ul. 
8. Apasaţi OK. 
 
Proiectul adaugă linia de evoluţie Gantt Chart, care arată asemenea liniei de evoluţie indicată 
anterior în Figura 12-22. 
Asa cum îţi puteţi  imagina, o linie de evoluţie la un proiect cu un numar mare de activitaţi poate 
incepe să arate dezordonată. Dar dacă te hotarasti că îţi place linia de  evolutie, le puteţi  afisa  la 
intervale variate de timp, asa cum am indicat anterior în Figura 12-23. Puteţi  de asemenea adauga 
date specifice listei Progress Line Dates în partea dreapta a  casetei Progress Line pentru a 
vizualiza multiple evoluţii în Gantt Chart. Dacă decizi să afişezi mai mult de o linie de evoluţie, va 
trebui să utilizezi tab-ul Line Styles a casetei Progress Lines pentru a formata liniile astfel încât să le 
accesezi separat (de exemplu, le puteţi  schimba culorile). 
Pentru a opri afişarea liniiilor evoluţiei, redeschideţi caseta Progress Lines şi deselectaţi orice check 
box din tab-ul Dates and Intervals. 
 

 

 



Aplicaţii 

 

O companie aerospaţială a primit o comandă de la NASA pentru asamblarea unui modul spaţial 

(NASA.mpp). S-au identificat două tipuri de resurse critice necesare pentru proiect: ingineri şi 

tehnicieni. Informaţiile despre activităţi sunt date în tabelul de mai jos. Activităţile sunt de tip Fixed 

Duration şi Effort Driven. 

 

 

Numele activităţii 
Durata 
(zile) 

Costul 
material 

Ingineri 
necesari 

Tehnicieni 
necesari 

Construct Shell of Module 30 35000 3 7 

Procure Life Support System and Experimentation Package 15 50000 1 5 

Procure Components of Control and Navigational System 30 80000 1 3 

Wire Module 3 4500 1 5 

Assemble Control and Navigational System 7 1500 2 5 

Preliminary Test of Life Support System 2 1500 1 5 

Install Life Support in Module 7 1000 1 5 

Install Experimentation Package in Module 3 1200 2 4 

Preliminary Test of Control and Navigational System 4 1800 2 4 

Install Control and Navigational System in Module 10 3000 2 3 

Final Testing and Debugging 8 4800 3 3 

 

 

Se consideră că proiectul necesită 5 ingineri şi 15 tehnicieni. Un inginer este plătit cu 100 $ / oră iar 

un tehnician cu 35 $ / oră. Orele suplimentare se plătesc cu o rată de 150% faţă de orele de program 

normal. 

 

Data de start a proiectului este 6 aprilie 2009. Începând cu data de 1 mai 2009, salariul de bază al 

inginerilor va creşte la 120 $ / oră. 

 

 

1. Care este estimarea privind costul total al proiectului? Salvaţi această linie de bază (baseline). 

Aici, toate persoanele lucrează full-time, fără ore suplimentare. 

 

2. Pe data de 20 mai 2009, activităţile se opresc pentru 2 săptămâni. Reflectaţi această situaţie în 

proiect. 

 

3. După această dată, pentru activităţile rămase, lucrează numai 4 ingineri şi 12 tehnicieni. Toate 

persoanele sunt dispuse să lucreze 2 ore suplimentare pe zi. În aceste condiţii, care este costul final 

minim al proiectului? Costul minim presupune reducerea cât mai mult a numărului de ore 

suplimentare. Care este diferenţa faţă de estimarea iniţială?  

 

Numărul total de ore lucrate (Work în Project Information → Statistics) trebuie să fie la fel în linia 

de bază şi în lucrul efectiv. 

 

 

Indicaţii 

 

1. Costurile materiale ale activităţilor corespund costurilor fixe care pot fi setate din tabela de 

costuri: 

 

 



2. Costul variabil al resurselor se poate seta din fereastra de informaţii despre resurse: 

 

 
 

 

 

3. Se recomdandă alocarea mai întâi a resurselor pentru activităţile/perioadele care impun cele mai 

multe constrângeri, de exemplu când 3 activităţi se desfăşoară în paralel. 

 

În planificarea iniţială, activităţile Construct Shell of Module, Procure Life Support System and 

Experimentation Package, Procure Components of Control and Navigational System necesită  

7 + 5 + 3 = 15 tehnicieni iar activităţile Assemble Control and Navigational System, Install Life 

Support in Module şi Install Experimentation Package in Module necesită 5 + 5 + 4 = 14 tehnicieni. 

 

După alocarea corectă a resurselor la aceste activităţi, se pot aloca resurse şi pentru celelalte. La fel 

se procedează şi pentru ingineri. 

 

 

4. Întârzierea cu 2 săptămâni se realizează cel mai uşor cu ajutorul celor două funcţii din fereastra 

Update Project. 

 

 

5. După întârziere, din nou apar 3 activităţi în paralel, care necesită iniţial 5 ingineri. Într-o zi, 

aceştia ar lucra împreună 40 de ore. După 20 mai, rămân doar 4 ingineri, care pot lucra 10 ore pe zi. 

Prin urmare, cele 8 ore ale inginerului eliminat trebuie transferate celor 4 ingineri rămaşi. Inginerul 

care nu mai lucrează după 20 mai trebuie să rămână în continuare alocat la activităţile dinainte de 

20 mai! La fel se procedează şi pentru tehnicieni. 

 




